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Within this use case you recognize a physical association of stars close in space as
opposed to a superpositon created by projection effects of stars very far one from the
others. The key measure is distance derived from parallax. With the true members of the
association (open cluster) you create a Herzsprung-Russell diagram as in use case 2. The
Herzsprung-Russell diagram of stellar clusters is very important because of the low noise

of few unrelated stars.

If used in the classroom this advanced use case requires a reasonable understanding of
histograms and bidimensional scatter diagrams. It is also rather long to perform from

beginning to end.

1 Introduction

Open star clusters are groups of stars
close together, gravitationally bound and
moving in space as a individual system.

In a open cluster stars are rather
scattered surrounded by gas clouds.
They contain few hundreds stars weakly
gravitationally bound. They are called
‘open” distinguishing them from globular
clusters that are round and compact.

In the Milky Way astronomers have
observed about 300 open clusters. The
best known and easiest to recognize is
the Pleiades open cluster, which is
observable by naked eye.

Star clusters are important for stellar
evolution studies. The stars belonging to
a cluster originate from the same gas
cloud, so they have the same age and
initial chemical composition. This allows

astronomers to obtain fundamental
information on how the mass of stars
affects stellar evolution. In fact, within a
cluster, the mass is the only physical
parameter free.

In this tutorial we learn how to use Aladin
to visualize the parallax of stars, a
distance measurement allowing us to
assign stars to the cluster. Then we will
build the color-magnitude Hertzsprung-
Russell diagram to study the cluster
evolution.

2 Parallax

Astronomers use the parallax to measure
the distance of stars. The parallax is the
angle between the directions in which we
observe a nearby star, when we see it
from two different positions either on the
Earth, or at different positions of the Earth
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along its orbit around the Sun. The
parallax decreases as the distance of the
star increases. Distances between
observing locations have to be as large
as possible in order to detect the
parallactic angle. For this reason
astronomers observe stars from two
opposite points of the Earth orbit. They
compute the position of the star once
every six months, from two points at 300
millions kilometers one from the other.
Astronomers use the “parsec" as unit of
measurement for the distances of stars.
One parsec is the distance from which
the radius of the Earth orbit is seen under
an angle of one arcsec. A star one parsec
away from us has a parallax of one
arcsec. Parallaxes are very small angles,
as an example, one arcsec is the angle
under which you would see a soccer ball
46 km far.

3 Stellar evolution

The Hertzsprung-Russell (HR) diagram
displays absolute magnitude of stars
versus their spectral type. It is a
fundamental diagram for stellar evolution
studies. During their life-cycle stars move
along a path in the HR Diagram.

The Hertzsprung-Russell diagram of a
cluster is easy to build because we can
use apparent magnitude instead of
absolute magnitude: we do not need
information on distances. Stars belonging
to a cluster are all at the same distance
from us, they originate at the same time
and from the same gas cloud. Hence they
have the same age and initial chemical
composition: the differences in luminosity
between members of the same cluster
are due only to the mass of stars. This is
the fact that makes stellar clusters very
useful for stellar evolution studies.
Looking at the Hertzsprung-Russell
diagram of a cluster we can see that most
stars lie in a limited region of the diagram,

called the “main sequence". This fact
suggests that color and magnitude are
related.

More massive stars run out their nuclear
fuel in a little time and begin to move
towards a new region in the upper right
part of the diagram. This new region is
called “giant branch”. Giant stars are very
big, and thus very luminous, but relatively
cold. Astronomers use the end point of
the main sequence to compute the cluster
age.

The Hertzsprung-Russell diagram is the
cornerstone of our knowledge on stellar
structure and evolution.

4 Aladin

ladin is an interactive sky atlas developed
and maintained by the Centre de
Donnees astronomiques de Strasbourg
(CDS) for the identification  of
astronomical sources through visual
analysis of reference sky images. It is
available here:
https://aladin.u-strasbg.fr/java/Aladin9.0.jar.
Aladin allows the user to visualize
digitized images of any part of the sky, to
superimpose entries from the CDS
astronomical catalogues and tables, and
to interactively access related data and
information from various data servers
(like SIMBAD, NED, VizieR).

In this usecase we use Aladin in the
undergraduate mode (developed in the
framework of the EuroVO-AIDA European
project).

5 Load the image of the Pleiades

Start Aladin and switch to the
undergraduate mode from the menu:

edit -> user preferences -> profile ->
undergraduate.
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Restart Aladin in order to validate the new
configuration.

Our aim is to study the properties of stars
belonging to Pleiades. We start loading in
Aladin an image of the Pleiades and a
catalog.

Open the server selector window:

File -> Load astronomical image
-> Aladin image server

In the field “target" enter “pleiades”.

® o)

NOTE: In this tutorial when you find the
mouse icon it means you have to click the
button next to the icon.

Select the image “POSS Il J 6.5 x 6.5
deg"

® o)

POSS is the acronyms of Palomar
Observatory Sky Survey: it is a collection
of digitalized photographic plates
covering all the sky accessible from the
Northern hemisphere (from a declination
of +90 to -27 degrees), taken at the
Palomar Observatory. All these images
are  astrometrically calibrated, i.e.
coordinates have been assigned to each
point.

Then we choose “The Hipparcos and
Tycho Catalogues” which contains also
data on parallaxes, measured by the
Hipparcos satellite.
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Fig. 1: The image and catalog selector window of
Aladin.

In the server selector window (fig. 1) (in
the rlght column)

‘@ } @

In the field “Author, free text" enter
“parallax"

Select "1/239" (The Hipparcos and Tycho
Catalogues, fig. 2) and return in the
server selector window. In the field
‘catalog" “1/239" appears, in the field
“‘Radius" enter “5 deg".

L '_,
"
. SUBMIT
21 catalog(s) found around pleiades g@

Catalogs
Name Category = Density = Description
|1/196 |loptical |2 |Hipparcos Input Catalogus, Version 2 (Tur...| a
Jopmcai 2 |Yale Trigonometric Parallaxes, Fourth Edi...
2 The Hipparcos and Tycho Catalogues (ESA 1...
1/256 optical 2 Carlsberg Meridian Catalogs (CMC, 1999)
1/280A optical |2 All-sky Compiled Catalogue of 2.5 million...
J/AN/325/740 |optical |2 lAstrophysical supplements to ASCC-2.5 (Kh...
1/62C optical |1 Perth 70: Positions of 24900 Stars (Hog+ ...
|_|lzzee optical |1 Brorfelde Meridian Catalogues 1964-1976 |..
1/143 optical 1 Fourth Fundamental Cat and Suppl (FK4, FK
1/144 optical |1 First, Second and Third Herstmonceux Cats.
1/250 optical |1 The Tycho Reference Catalogue (Hog+ 1998)
I/311 optical |1 Hipparcos, the New Reduction (van Leeuwen.
I11/254 optical |1 2nd Cat. of Padial Velocities with {X:c;om
V/323 optical b Stars within 25 pc of the Sun (Woolley+ L.
V/3EB optical |1 Supplement to the Bright Star Catalogue (.
v/50 optical |1 Bright Star Catalogue, Sth Revised Ed. (H...
V/53A optical |1 Catalogue of the Brightest Stars (Ochsenb...
V/70A optical |1 Nearby Stars, Preliminary 3rd Version (Gl...
v/108 optical |1 |SKY2000 Catalog, Version 4 (Myers+ 2002)
J/A+A/381... |optical |1 |Astrometric Radial Velocities. ITT. (Mads...|™ |
[ svemrr ) (roeet ] [ )

Fig. 2: List of catalogues available in Aladin.
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6 Compute the histogram of parallax
Open the tool VOPIlot from the menu:
Tools -> Vo Tools -> VOPIot

Right click on the plane of the catalog
“1/239/hip_main” and broadcast the data
to VOPIot through (fig. 3):

Broadcast selected tables to -> VOPIot

Move in the VOPIot window (fig. 4).

® I

In the field “X coordinate" select
“‘parallaxes” (pIx) and set “binwidth™=1.

The plot in figure 5 appears. It represents
the histogram of parallaxes of stars of the
Pleiades image loaded in Aladin.

Looking at the plot we can see that the
parallax of the Pleiades cluster is around
8-9 mas (milliarcsec), that there are many
background stars (smaller parallax) and a
few foreground stars (larger parallax).
The real value of Pleaides parallax is 8.46
+/- 0.22 mas.
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Fig. 3: Broadcast data to VOPIot.
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Fig. 4: Main window of the VOPIot tool.

7 Visualize the Hertzsprung-Russell
diagram

In order to correctly build the H-R
diagram we have to correct data for
reddening. Astronomer call “color’ of a
star the difference between its magnitude
in the Blue and in the Visual band (B-V).
The matter in the Universe absorbed and
scatter more blue light than red light: this
effect is called reddening (see the box)
because we see a star more red than
how it really is.

v VOPIlot - file://localhost:-1//C:/Documents ... [= [[E1]BX]
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You are currently in Select mode.

Fig. 5: Histogram of parallaxes of stars in the
Pleiades image.
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Thus the observed color (B-V) has to be
corrected for the reddening. For this
cluster the reddening amounts at 0.04
mag, So:

(B-V)o = (B-V) - E(B-V) = (B-V) - 0.04.

Reddening

Reddening is one of the effects caused
by the interstellar medium: blue light is
absorbed and scattered more than red
light. As a consequence the color index
B-V (the difference between the
magnitude in B band and the magnitude
in V band) increases. Reddening is due to
the grains of dust of the interstellar
medium, between us and the Pleiades.
Grains of dust absorb and scatter the light
with wavelength comparable with their
size: shorter wavelengths (blue light) are
largely absorbed and scattered, while
longer wavelengths (red light) can easily
pass through the interstellar medium.

We add a new column in the catalog, with
the (B-V) values corrected for the
reddening (B-V)o. Select the catalog
plane and open the menu

Catalog --> Add a new column

In the field “Name" enter “(B-V)o". In the
field “Expression" enter “$(B-V) - 0.04"

(fig. 6).

Ca
&
‘ Add new column

Select some stars of the image and look
at the table in the lower part of the Aladin
window. Move the scroll bar to the right
and verify the new column (B-V)o has
been added.

Column calculator Q@

Add a new column to plane 1.239.hip_main

Name itB-V)_O
ucoD ‘
Unit

Keep 4 v | decimals

Expression  eg ${8mag-§{Vmag}
${B-v}-0.04

Pick up a column name

[ HIP ] [ RAhms ] [ DEdms ] [ Vmag ]
[ Raacrs) || DEGCRs) || Px |[ pmRA |
[ pmDE ] [ e_Plx ] r B-V ] [ Notes ]

Pick an operator / a function

[ Add new column J[ Close ]

Fig. 6: The window to add a new column.

Broadcast the plane of the catalog to
VOPIlot as done before (fig. 3) and move
in the VOPIlot window.

o

In the field “X coordinate" select “(B-V)o".
In the field “Y coordinate" select “Vmag".
Check the option “rev" of the Y axis (fig.
7).

‘*‘ Plot

The Hertzsprung-Russell diagram of the
Pleiades appears in the VOPIlot window
(fig. 7), it is easy to recognise the main
sequence. If you select some points in
the plot the corresponding stars are
highlighted in the image loaded in Aladin.

Mode -> select mode
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Select some stars drawing a rectangle s %
(drag and drop the mouse) around them, e % . x
to share information between VOPIot and o
Aladin use the menu (in VOPIot): “x. il

x
3K

Interop -> Show Obijects in -> Aladin

In order to know if some stars belong to T - >
the cluster we have to select them and ‘ -

look at their parallax in the table loaded in = X S
Aladin. Select the points up left in the plot

(brightest stars) and note that they

correspond to the central stars of the

image. From the data in the table you can

see that their parallax is 8-9 mas: they

belong to the Pleiades.

Now select some points in the bottom

right (faintest stars) part of the plot: they

correspond to stars at the edge of the

image. Looking at their parallaxes we see

that they are mostly background stars

(parallax < 8 mas) with a few foreground

stars (parallax > 8 mas).
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Fig. 7: The Hertzsprung-Russell diagram of the
Pleiades cluster.
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